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About This Book

Purpose 

This guide describes how to use the Integration Module for Enterprise - Custom Edition to create Identity 
Manager drivers. This product has design-time as well as runtime executables and uses J2EE Connector 
Architecture technology to provide integration capability.

Audience

This book is for developers who are planning to use Novell exteNd Composer to develop drivers for 
Identity Manager. 

Prerequisites

You should be familiar with the exteNd Composer work environment and deployment options. You 
should be familiar with the external application that you want to integrate with eDirectory, and you 
should be familiar with the Composer Connect that provides access to the API of the external application. 
You should also be familiar with eDirectory and the basics of developing Identity Manager drivers. 
Familiarity with Java Connector Architecture is helpful but not required.

Software Versions

The following software versions are required to use the Integration Module for Enterprise - Custom 
Edition:

exteNd Composer Version 5.2.1 (Enterprise), build 1307D or higher (to check the Composer build 
level, select Help > About Composer; then select the System button). You can find exteNd 
Composer patches at the following URL: http://support.novell.com/filefinder/15595/index.html.
eDirectory 8.7.3 or higher
Identity Manager 2 or higher

Additional Documentation

For the complete set of Novell exteNd documentation, see the Novell Documentation Web site 
(http://www.novell.com/documentation-index/index.jsp).
9
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1 Introduction

Welcome to the Integration Module for Enterprise - Custom Edition. This Guide is a companion to the 
Novell exteNd Composer User’s Guide, which details how to use all the features of exteNd Composer 
except for the Connect Component Editors. Novell exteNd Composer™ provides separate Component 
Editors for each Connect. The special features of each Connect are described in separate Guides. You 
should be familiar with the Novell exteNd Composer User’s Guide and the Guide for the Connect that you 
will be using before using this Guide.

NOTE:  To be successful with this Integration Module for Enterprise - Custom Edition, you must be 
familiar with the external application system that you are integrating with Identity Manager, and with the 
Composer Connect for that application system.

About Novell exteNd Composer™ 
Novell exteNd Composer is the XML integration-broker component of the Novell exteNd suite. It 
encompasses a set of design tools for building XML integration applications and Web services, plus a 
runtime engine that enables execution and administration of the services that you build. The applications 
and services that you build with exteNd Composer can be deployed to any popular J2EE application 
server or servlet container. Supported application servers include JBoss, IBM WebSphere and BEA 
WebLogic in addition to the Novell exteNd application server. Apache Jakarta Tomcat is also supported. 
Check the Novell web site for latest platform-support information. 

At the core of exteNd Composer is a robust XML transformation engine capable of performing a wide 
range of data transformations, including joining of multiple documents, decomposition of documents, 
and creation of entirely new documents. The underlying enabling technologies include XSLT, XPath, 
ECMAScript, and Java. The exteNd Composer design environment offers a rich, intuitive graphical user 
interface, making it possible for you to specify XML transformations and mappings visually, using 
wizards, dialogs, and drag-and-drop gestures. You never have to write raw XSL or Java code.

exteNd Composer supports numerous kinds of data-source connectivity, through individual adapters 
called Connects. Using the functionality exposed in the various Connects, you can design enterprise 
application integration (EAI) applications and Web services that pull data in from or push data out to 
different kinds of back-end systems, using a variety of transport protocols and technologies, ranging from 
3270 and 5250 terminal data streams to Telnet, HP3000, Unisys T27 (and UTS), Tandem, and Data 
General, in addition to HTML screen-scraping, JMS messaging, and CICS RPC transactions. You can 
also take advantage of JDBC, LDAP, and other mechanisms to reach back-end data repositories and 
systems that might or might not natively understand XML. Composer Connects allow you to connect to 
these systems inobtrusively, so as to marshall non-XML data into XML form or vice versa without any 
need to modify host-system setups or code. 
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In addition to legacy data-stream and protocol-specific Connects, exteNd Composer has Connects for 
ERP and CRM systems, including Baan, PeopleSoft, SAP, Lawson, J.D. Edwards, Siebel, and Oracle 
Applications. As with other Connect solutions, the ERP and CRM Connects are fully integrated into 
exteNd Composer’s design-time environment so that you can use intuitive visual tools to create powerful 
custom integration solutions, eliminating the need to write Java code or edit raw XML or schemas by 
hand. You can also test the components that you build against live connections, using the animation 
facility (step-through debugger) of the design environment. As part of the design and debug process, your 
application-aware components can call other exteNd Composer Components (such as XML Map 
Components, JDBC Components, etc.) and make use of any of the core actions that exteNd Composer 
defines (such as Map, Function, Log, and other actions).

About the exteNd Composer Integration Module for Enterprise - 
Custom Edition 

The exteNd Composer Integration Module for Enterprise - Custom Edition consists of the following 
major components:

Composer Service Driver (ComposerDriverShim.jar, Composer runtime files, and a configuration 
file), which acts as a bridge between Identity Manager and exteNd Composer. The Composer 
Service Driver is installed automatically to eDirectory when you deploy a driver from exteNd 
Composer. It is also included in Identity Manager 3. 
A collection of template xObjects that can be added to any new exteNd Composer project when the 
project is created. The template xObjects demonstrate how to create Web services that support the 
Identity Manager commands and events specified in the NDS.dtd, and that detect changes in the 
external application and publish the changes to Identity Manager. 

Using the Integration Module for Enterprise - Custom Edition, you can write exteNd Composer Action 
models that integrate with external applications. Action models connect to external applications through 
a Composer Connect and perform creates, deletes, modifies, and queries as specified by the Identity 
Manager API.
12   Novell Integration Module for Enterprise - Custom Edition Guide



Connector logic in exteNd Composer is encapsulated in a component that contains an Action model. An 
Action model is composed of generalized programming constructs and connector-specific actions. The 
component accepts XML as its input, performs general and connector-specific actions, and returns XML 
as its output. This enables applications written in exteNd Composer to call external applications using a 
pure XML interface. In a Subscriber model, the connector-specific actions transform the XML input into 
a format usable by the external application. The connector-specific action then interprets this format and 
makes native API calls to the target system as a request, accepts the response from the external 
application, and returns the response back to the component in XML format. This XML can then be 
processed further or used as the output of the component. In a Publisher model, a target-specific exteNd 
Composer listener component receives XML from the XML API, applies any business logic, and 
essentially mirrors the Subscriber process.

An Action model can make multiple API calls and apply any type of data mappings, transformations, 
constraints, rules, and policies to the data before or after communications with the target host. exteNd 
Composer then generates the XML documents defining the information needed for the functions of the 
external application.

At runtime, the Composer Connect receives each Composer-generated XML document and creates the 
actual function call to the API of the external application, using the information contained in the received 
XML documents. The Composer Connect contains no application integration logic. Application logic is 
implemented in the Action model, not the connector. This requires the exteNd Composer developer to 
have a detailed understanding of the APIs available in the connected system and how those APIs are used 
to accomplish the desired task. 
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Which External Applications are Supported?
The exteNd Composer Integration Module for Enterprise - Custom Edition provides a framework for 
developing Identity Manager drivers. You can use this framework for developing drivers for any 
application system for which there is a corresponding Composer Connect (see your exteNd Composer 
documentation for a complete list of Composer Connects). All Composer Connects provide Subscriber 
channel support. In addition, exteNd Composer provides Publisher channel support in the following 
Connects:

Baan
Lawson
J.D. Edwards
JMS
Oracle Applications
PeopleSoft
SAP
Siebel

What Kinds of Applications Can You Build Using the Integration 
Module for Enterprise - Custom Edition?

You can use the Integration Module for Enterprise - Custom Edition to build custom applications that 
connect disparate directories using eDirectory and allow data to be automatically shared and 
synchronized across directories. The drivers can connect directories despite different naming 
conventions and schema definitions. You can build any kind of Web service or integration application 
that needs to push data into or pull data from eDirectory using XML as the interchange format. 

Where Should I Start?
If you are new to Identity Manager driver development, Novell DeveloperNet® University provides a 
free, online Identity Manager driver creation training course. Although the course teaches how to develop 
drivers using C++ or Java (while exteNd Composer uses an Action model developed in Composer’s high 
level language), it provides an excellent background to Identity Manager driver development.

DeveloperNet University: Custom Driver Development Course: 
http://developer.novell.com/education/tutorials/dirxml2/01.htm

The Novell Identity Manager Driver Kit (NDK) also includes documentation that provides background 
information about Identity Manager driver development:

http://developer.novell.com/ndk/dirxml.htm
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2 Getting Started

Enabling the Integration Module for Enterprise - Custom Edition 
Feature

The Integration Module for Enterprise - Custom Edition feature is not enabled in exteNd Composer by 
default. You must enable the feature by editing the exteNd Composer configuration file, xconfig.xml.

To enable the exteNd Composer Integration Module for Enterprise - Custom Edition feature:

1 If you haven’t already done so, install exteNd Composer (see the Installing Novell exteNd manual).
2 If exteNd Composer is running, exit from Composer before performing the following steps.
3 Locate your xconfig.xml file in the /Composer/Designer/bin directory and open the file in a text 

editor. 
4 Locate the element named “IDM2_WIZARD ENABLED”.
5 Change the value of this element to TRUE (IDM2_WIZARD ENABLED="TRUE").
6 Save your changes.

Creating an Integration Module for Enterprise - Custom Edition 
Project

To create a Integration Module for Enterprise - Custom Edition Project:

1 Start exteNd Composer.
2 Select New Project from the File menu. The New Project dialog box is displayed:

3 Select the IDM2 Driver Project option (located in the lower left of the dialog box). This is the 
option that enables the Integration Module for Enterprise - Custom Edition feature.

4 Type in a Project Name. This is a required field. Composer adds the project name extension (.spf).
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5 Select Browse to locate the directory in which you want your project to reside. The Project 
Location dialog box is displayed.
NOTE:  If you have a project open, the Project Location dialog box shows the directory where the 
open project resides.

6 Navigate to the directory in which you want your project to reside. If necessary, create a new 
directory for the project.
NOTE:  The File Name in the Project Location dialog defaults to the project name you designated 
in Step 4.

7 Click OK. The New Project dialog appears with the Project Name and Project Location 
displayed.

8 Enter a deployment context string in the Deployment Context in the project JAR field. The string 
should contain labels (no spaces) separated by periods, as in “com.server.apps.”
NOTE:  The context string should not contain Java-language keywords, such as try, catch, finally, 
int, or for. For a complete list of Java keywords, see the “Reserved Words” appendix in the Novell 
exteNd Composer User’s Guide.

9 Click OK. The Composer window appears with the name of the project that you just created in the 
title bar. You can view the template artifacts that are included in the project by using the Project tab 
in the Navigator Frame. For example, to view the Web services that are included in the project, 
scroll down to the Services section of the Navigator Frame, then double-click on Web Services:
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The next step is to create a server profile for Identity Manager, which you will need when you 
deploy your project.

Creating a Server Profile
To create a server profile:

1 Select Profiles from the Tools menu. The Profiles dialog box is displayed:

2 Select New. The New Server Profile dialog box is displayed:
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3 Type a name for the profile in the Profile Name field.
4 Select Novell IDM2 from the Server Type list.
5 Use the browse button in the Deployment Path field to select the eDirectory “lib” directory (on 

Windows this is \NDS\lib; on Linux or UNIX this is /usr/lib/dirxml/classes).

6 Use the Target OS list to select the operating system to which you will deploy your driver.
7 Select OK. Composer returns you to the Profiles dialog box.
8 Select Close.
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What is Included in the Integration Module for Enterprise - Custom 
Edition

The Integration Module for Enterprise - Custom Edition includes a set of xObjects that need to be part of 
any driver development project. These xObjects include:

Web services - provided as entry points into the Composer action model 
XML Map Components
XML Resources
XML Templates
Deployment xObject

The following sections describe these xObjects.

Web Services
The following table lists the Web service definitions supplied with the Integration Module for Enterprise 
- Custom Edition. These definitions are intended to serve as placeholders or stubs; you must customize 
them to work in your environment. The names of the Web services are very important (because they are 
used by the ComposerDriverShim.jar to call the services) and must not be changed.

Web Service Description

Initialize Sets up connection information used by the other services. Declares and 
sets session variables. Checks for loopback condition and creates a 
session variable to hold status of loopback condition check (true, false). 
Note: Although the DirXML engine prevents loopbacks, it’s a best practice 
for efficient operation to check for and prevent loopbacks in the driver.

InitializePublisher Initializes the Publisher channel. Checks session variable for the type of 
input (for example, “memory”, “file”) and performs appropriate setup tasks. 
Creates session variables for publisher options.

InitializeSubscriber Initializes the Subscriber channel. Creates session variables for 
subscriber options.

Execute Checks input for type of command (add, delete, modify, query), and 
performs the appropriate actions.

GetEvents Used by the publisher to get events from a vector session variable.

GetSchema Called by the ComposerDriverShim.jar. Returns the schema from the 
external application.

Shutdown Removes variables created for the driver and stops services.
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XML Map Components
XML Map components manipulate and transfer data from one XML document to another. The XML 
Maps are used by the Web services.

XML Resources
The Integration Module for Enterprise - Custom Edition includes the following XML Resources. The 
XML Resources are provided as samples; they are not used in the project except where noted in the table.

XML Map Description

AddUser Called by Execute. Uses an XML Interchange action to read data from an 
XML file into the DOM. Performs any necessary transformations, then 
uses another XML Interchange action to write the data to a file. In practice, 
the functionality in the component would probably be placed in an 
application-specific component (for example, a Siebel component). This 
component provides an example action model for adding a user to 
another system.

Check Stored events Called by GetEvents. Checks for loopback condition.

Clean Stored events Called by GetEvents. Used to clean up stored events to remove loopback 
condition.

DeleteUser Called by Execute. Used to delete a user. Provides an example of using a 
Send Mail action to provide notification of the attempted deletion.

Map Connection Values Called by Execute, Initialize, and Initialize Publisher. Used to map 
connection values to a Project Variable.

Modify Called by Execute. Provides a placeholder for code to handle a Modify 
event. On the subscriber channel, this is a request to the external 
application to modify an entry. On the publisher channel, this is a 
notification to Identity Manager that an item in the external application has 
been modified.

Query Called by Execute. Provides a placeholder for code to handle a Query 
event.

Store Events Called by Execute. Used to store events.

XML Resource Where Used

AddressSchema

AddReply

Address

AddSample

AddUser

Association Store Events

ClassUser AddUser, GetSchema

Connection

DeleteUser

FullSchema
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XML Templates
XML templates contain sample documents, schemas, and stylesheets to assist you in designing and 
testing components. The following table lists the XML Templates included in the Integration Module for 
Enterprise - Custom Edition.

Deployment xObject
The Integration Module for Enterprise - Custom Edition includes a deployment xObject named “Demo”. 
The deployment xObject contains metadata about your deployment (information about which service 
triggers to create and which resources to deploy). You can view the deployment xObject by scrolling to 
the bottom of the Navigator frame and clicking on Deployment. The names of deployment xObjects that 
have been defined in the project are displayed below the Navigator frame. Right-click on “Demo” and 
select Properties to view the properties of the Demo deployment xObject.

IdentifyReply Execute

ndsModify3

publish GetEvents

Query

reply AddUser, DeleteUser, Modify, Query, Execute, Initialize, 
InitializePublisher, InitializeSubscriber, Shutdown

SampleDelete

SampleInit

SampleModify

SampleOutputfromQuery

SampleQuery

UserSchema GetSchema

XML Template Where Used

AddUser AddUser (XML Map), Check Stored events, Clean Stored events, Store 
Events, Execute

Connection Initialize, InitializePublisher, InitializeSubscriber

DeleteUser DeleteUser (XML Map)

IdentQuery

ndsModify Modify

ndsModifyOut

Query

Reply

Sampleschema

Schema GetSchema

UserSchema

XML Resource Where Used
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What You Must Supply
You must customize the artifacts supplied in the template (Web services, XML Maps, XML 
templates and resources, and deployment object) for your specific project. 
You must define Composer connection resources for the external application. For example, if you 
are integrating with a Siebel application, you must define a Siebel connection resource. Refer to the 
Composer Connect documentation for the external application with which you are integrating for 
information about creating a connection resource. For example, if you are integrating with a Siebel 
application, refer to the Novell exteNd Composer 5.2.1 Connect for Siebel User’s Guide.
You must author the components that provide the application-specific logic for the external 
application that you want to integrate with Identity Manager. Refer to the Composer Connect 
documentation for the external application with which you are integrating for information about 
creating an application-specific component. For example, if you are integrating with a Siebel 
application, refer to the Novell exteNd Composer 5.2.1 Connect for Siebel User’s Guide.
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3 Deploying the Driver

Deploying the Driver from Composer
This section describes how to deploy the Integration Module for Enterprise - Custom Edition portion of 
your project. To deploy project components that connect to external applications, refer to the 
documentation for the Composer Connect for the external application, and to the Novell exteNd 
Composer User’s Guide.

To deploy the Integration Module for Enterprise - Custom Edition portion of your project:

Before you deploy the driver, make sure that you have set up a Server Profile and specified the 
deployment path (see “Creating a Server Profile” on page 17).

NOTE:  For more information about deployment options, see “Deploying Your Project,” in the Novell 
exteNd Composer User’s Guide.

1 In the Project tab in the Navigator Frame, scroll down to the bottom and click on Deployment.

The Integration Module for Enterprise - Custom Edition includes a sample deployment xObject 
named “Demo”. You will probably want to change this name to better describe your project.

2 Right-click on the Demo deployment xObject, and select Properties. Composer displays the 
deployment Properties dialog box.

3 Select the Deploy tab. 
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4 Composer fills in the Deployment Object Name field with the name of the deployment xObject. If 
desired, change the Deployment Object Name to a name that is appropriate for your project.

5 Composer fills in the Deployment Context in the Project JAR field with a default deployment 
context. If desired, change the deployment context in the Deployment Context in the Project 
JAR field to one that is appropriate for your application.

6 Composer fills in the Base URL field with a URL based on the deployment xObject name. If 
desired, change the Base URL to one that is appropriate for your project.

7 If desired, change the default path in the Deployment Staging Directory field. Composer uses this 
directory as a working directory during deployment, creating deployment objects and descriptor 
files. 

8 Select OK.
9 In the Navigator frame, right-click on the name of the deployment object and select Deploy 

Project. The Deployment dialog box is displayed.
10 Select Deploy. Composer deploys the project using the deployment path specified in the server 

profile for the project.
NOTE:  If you have previously deployed your driver, made a change, and redeployed, you may 
receive a message in the Composer System Output pane that some files (for example, xconfig.jar) 
could not be copied (“access denied”). This is because the files in question are already in the NDS 
lib directory from a previous deployment, and they are locked by eDirectory. If you have not made 
changes that affect the functionality of your Composer environment (for example, enabling a 
Connect; changing license strings for a Connect) you can ignore the message. If you have made 
changes that affect the functionality of your Composer environment, then your xconfig.jar has 
changed, and you will need to stop the eDirectory server, then repeat the steps in this procedure to 
deploy your project from Composer.
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Configuring the Driver in Identity Manager

Creating the Driver Object

To create the driver object:

1 Log into the instance of iManager that manages your eDirectory server.
2 Open the DirXML Utilities node in the iManager navigation frame. 

3 Select New Driver. The Create Driver Wizard is displayed:

The next step is to select where you would like to create the new driver. You can create the driver in 
an existing driver set, or create a new driver set.
NOTE:  When you set up a new driver, you can usually place the driver in an existing driver set. 
Use a new driver set for the first driver in a new Identity Manager installation. See the Identity 
Manager documentation for detailed information about driver sets and the iManager procedures for 
creating and configuring driver sets. 

4 Select a driver set option, then select Next. The next screen in the Create Driver Wizard is 
displayed:
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5 Select the Import a driver configuration from the client option, then select the Browse button 
and navigate to the ComposerDriver.xml file in the 
\Novell\exteNd5\Composer\Designer\lib\IDM2 directory. Select the file, then select Open to return 
to the Create Driver Wizard. 

6 Select Next. The Create Driver Wizard displays a page that you use to name the driver. 

The default name of the driver, from the configuration file, is ComposerDriver. While you can use 
the default name, you may want to choose a more meaningful name for your project.

7 If desired, type a new name for the driver in the Driver name field. 
8 Leave the Enter the driver password and the Enter the authentication password fields blank.
9 Select Next. A message indicating that the driver configuration is being imported is displayed, then 

the next page of the Create Driver wizard is displayed:
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The driver object must be granted sufficient eDirectory rights to any object that it reads or writes. 
You can do this by granting Security Equivalence to the driver object. The driver must have 
Read/Write access to users, post offices, resources, and distribution lists, and Create, Read, and 
Write rights to the post office container. Normally, the driver should be given security equal to 
Admin.
NOTE:  The next two steps can be completed at a later time, if desired (by using the iManager 
driver administration features), but we strongly recommend that you complete these steps now.

10 Click Define Security Equivalencies. A new window is displayed: 

11 Select Add. A window is displayed that you use to select an object in the tree that has the 
appropriate level of rights that you would like to assign to this driver (for example, “admin”). 

12 Select an object from the tree, then select OK. You are returned to the previous window.
13 Select OK. You are returned to the Create Driver wizard.
14 Select Exclude Administrative Roles. The Excluded Users window is displayed. 
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15 Select Add. A window is displayed that you use to browse the directory tree for users who should 
be excluded from having their data passed to the driver. Normally, you would exclude admin 
objects, since replicating their data across a driver connection is not good practice in most cases. 

16 Select the administrative roles that you want to exclude, then select OK. You are returned to the 
previous window.

17 Select OK. You are returned to the Create Driver wizard.
18 Select Next. A driver summary page is displayed.
19 Select finish with Overview. A graphical representation of the driver in eDirectory is displayed:

NOTE:  You can view this screen again at any time by using the DirXML Overview link under 
DirXML Management in the iManager navigation tree.

The new driver appears as a large icon connected to the eDirectory trunk. The next step is to 
configure driver settings.
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Configuring Driver Settings

To configure driver settings:

1 If the DirXML overview screen is not currently displayed, display it by selecting the DirXML 
Overview link under DirXML Management in the iManager navigation tree.

2 Click the large driver icon:

The DirXML Driver Overview is displayed: 

The top horizontal arrow represents the Publisher channel and the bottom horizontal arrow 
represents the Subscriber channel. As you pass the mouse pointer over an object in the graphic, a 
description of the object is displayed:

3 Click on the Schema Mapping Policies icon for the Publisher channel. The Schema Mapping 
Policies dialog box is displayed:

4 Select Edit. The DirXML Policy dialog box is displayed.
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5 Select Refresh Application Schema.
6 Select Add, then select the classes to map from the drop down lists under the eDirectory Classes 

and Application Classes lists:

7 Select Attributes. The DirXML Schema Mapping Policy Editor is displayed:

8 Select an attribute from the drop down list in the Application Attributes column; then select an 
attribute to which to map the application attribute from the drop down list in the eDirectory 
Attributes column. 

9 Select Add.
10 Repeat Step 8 and Step 9 until you have mapped all of the attributes that you need to map.

11 Select OK. You are returned to the DirXML Policy dialog box.
12 Select OK. You are returned to the Schema Mapping Policies dialog box.
13 Select Close. You are returned to the DirXML Driver Overview page.
14 Click the Driver Filter icon for the Publisher channel. 

The filter window is displayed: 
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Filters enable you to specify the classes and attributes that an application can send to and receive 
from eDirectory. The read-only Filter list on the left shows the attributes of the class. The Class 
Name list on the right displays options associated with the target object. Click the help button in the 
filter window for more information about the features of this window. 

15 Specify the attributes that the application can send to and receive from eDirectory. Select 
Synchronize for an attribute if you want changes to attribute values to be reported and 
synchronized. Select Ignore if you do not want changes to attribute values to be reported and 
synchronized.

16 Select OK. You are returned to the DirXML Driver Overview page.
17 Repeat Step 3 through Step 16 for the Subscriber channel.
18 Click on the driver icon (on the right side of the page) to display the Modify Object dialog box.
19 Check that the driver parameters are correct for your environment.
20 To start or stop the driver, click on the rounded “status indicator” in the upper right corner of the 

driver icon, and select the appropriate command from the menu.
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